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Chapter 1

Getting started

OpenText Fax FaxUtil is the mailbox where you manage your faxes and those for
whom you act as a delegate.

¢ The left pane shows the folders that contain faxes.

¢ The center pane shows the list of faxes within the selected folder. Flags indicate
the action taken on the fax, and status indicators show the current status of the
fax.

¢ The right pane displays a preview of the selected fax when the Tools menu is
enabled.

Fax flags: {F‘j = sent @ = received, - printed, izl = converted to text (OCR), -

—
converted to PDF, @ or L sent or received fax forwarded to another OpenText Fax

user. In addition, flags can indicate the document type: ®. certified delivery

message, H- SMS message, I'EI = Emailed, 53 = Fax routed to email.

Status indicators: O- preparing for transmission, = transmitted, = not

transmitted due to error; will be retried, 0 =not transmitted due to error; will not
be retried.

For detailed information about status messages, see “Fax status and error messages”
on page 65.

You can force the server to retry sending faxes that are in a yellow or red status. See
“Sending faxes” on page 9.

Note: If you forget your OpenText Fax password, contact your fax
administrator to assign a new one. To change your password, see “Changing
your password and default user information” on page 56.

FXNET240400-UFD-EN-01 FaxUtil User Guide 7



Chapter 1 Getting started

1.1 Showing the most current list of faxes

By regularly refreshing the fax list you ensure that you are looking at the faxes
currently stored on the fax server.

To refresh the fax list now:
e (lick Refresh.
To set the fax list to refresh regularly:

1.  On the Tools menu, click Options.

2. On the Other Options tab, select the Enable automatic fax list updates (secs)
check box, and then specify the number of seconds between the updates.

8 OpenText™ Fax FXNET240400-UFD-EN-01



Chapter 2

Sending faxes

2.1

2.2

You can create new faxes, forward or route existing faxes, and send faxes you held
for preview.

If you are a fax administrator or group monitor, you can also approve or disapprove
faxes that need approval. See “Responding to faxes needing approval” on page 11.

For information about broadcasting faxes to a large number of recipients, see the
OpenText Fax - Administrator Guide (FXNET-AGD).

Sending a new fax

1. Select the folder for creating the new fax.
2. Click New Fax. The fax gets saved in the Main folder.

3. Inthe New Fax window enter the destination—typically required are recipient
name, destination type, and a fax number or email address—and as needed,
add billing codes, cover sheet notes, and attachments, and specify other
processing options. See “Completing the fax information” on page 13.

4. Click Send. If required information is missing, do one of the following;:

e To send the fax now, click Cancel, fill in the information, and then click OK.

¢ To fill in the information later and hold the fax in a status of Information
Incomplete until then, click OK.

Forwarding or routing an existing fax

When you forward a fax, a copy of the fax is sent, and the original fax remains in
your mailbox. When you route a fax, the original fax is sent and removed from your
mailbox.

To forward to a fax number or email address:

1. Select the fax in the list, and then click Forward to Fax.

2. Inthe New Fax window, enter the information for sending the fax, and then
click OK. See “Completing the fax information” on page 13.

When forwarding a received fax to a fax number, you can add attachments.

To forward or route to a OpenText Fax user on your network:

1. Select the fax or faxes in the list, and then click either Forward to User or Route
to User.

FXNET240400-UFD-EN-01 FaxUtil User Guide 9



Chapter 2 Sending faxes

2.3

5.

In the Selected box, enter the OpenText Fax user IDs separated by commas.

To search for users, in the Search for Users box do the following:

a. Enter a full or partial user name or OpenText Fax user ID, and then click
Search.

b. Select the user, and then click Add. Repeat as needed for multiple
recipients.

indicates if a user account is disabled, i if it is unprotected.

In the Notes added to fax history box, enter any notes you want to add to the
document history.

To send the fax, click OK.

To forward or route to a delegate:

1.
2.
3.

In the left pane, expand Other Users.
Browse to locate the delegate.

In your list of faxes in the right pane, select one or more faxes and do one of the
following:

¢ To forward the fax, click and drag the fax to the delegate's name in the tree
view in the left pane.

* To route the fax, hold the shift key, and click and drag the fax to the
delegate's name in the tree view in the left pane.

Releasing a fax held for preview

When you release a fax held for preview it is queued to send.

If you created a new fax and selected the Hold for Preview option, the fax appears
in the fax list with a status of Held for Preview.

To send the fax, right-click the fax in the list, and on the shortcut menu, click
Status, and then click Release.

10
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2.4. Retrying a failed fax

2.4 Retrying a failed fax

A sent fax that encounters errors during transmission will be retried the number of
times configured by your fax administrator. It appears in the fax list with an error
status. After the specified number of retries, the server will stop retrying the fax and
the fax status changes.

To force the fax server to retry sending a fax:

* On the Fax menu, click Status, and then click Update Status. If the fax was
already scheduled to retry, the fax server will retry immediately and not wait for
the scheduled interval. If the fax was dropped, it will go back into the send queue
on the fax server as though you were sending a new fax.

2.5 Responding to faxes needing approval

A fax requires approval in the following cases:

* The sender's user account permissions require that faxes be approved by a fax
administrator or group monitor before sending.

¢ The sender's delegate permissions for the other user's mailbox require that faxes
be approved before sending.

¢ The fax is blocked by a dialing rule.

Note: If the fax is blocked by a dialing rule, only a fax administrator can
approve the fax.

To show faxes needing approval:

As a fax administrator or group monitor you can view all faxes needing your
approval.

1. On the List menu, click Needing Approval.

2. On the List menu, click Administrative Mode to view the contents of all fax
mailboxes for which you are a fax administrator or group monitor.

To approve a fax to send it:

1. Show faxes needing approval.

2. Right-click the fax in the list, and on the shortcut menu, point to Status, and
then click Approve.

3. Asneeded, in the text box, enter text explaining why you approve of sending
the fax. The note will appear in the approval record in the fax history.

4. Click OK. The fax will be sent.

FXNET240400-UFD-EN-01 FaxUtil User Guide 1"



Chapter 2 Sending faxes

To disapprove a fax to keep it from sending:

1.
2.

Show faxes needing approval.

Right-click the fax in the list, and on the shortcut menu, point to Status, and
then click Disapprove.

As needed, in the text box, enter text explaining why you disapprove of sending
the fax. The note will appear in the denial record in the fax history.

Click OK. The fax will not be sent. The sender's mailbox will show the fax with
a status of Fax was disapproved.

12
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Chapter 3

Completing the fax information

3.1

You enter all information for sending a fax in the New Fax window.

¢ To open this window, in the FaxUtil mailbox, click New Fax. The window also
opens when you click Forward to Fax to forward a fax to another fax number or
email address.

A bold label indicates that the information is required. If you click Send before
entering all required information, a message indicates the fields that need to be
completed. Click Cancel to fill in the missing information. To hold the fax in a status
of Information Incomplete, click OK.

Note: Some options may affect the time it takes to generate and send the fax.

Entering the fax destination

In the New Fax window, under To, select the destination from your phonebook or
enter it manually. Your user account permissions determine if you can enter a
destination manually or if you must select from a phonebook.

When sending a fax to an email address, you can send select file attachments in their
native format and specify file attachments as alternate body pages that should
appear in the body of the email. Depending on optional OpenText Fax modules, you
may also be able to:

* Send via certified delivery. The fax is sent to a special secure Web site and a
message to the recipient's email address that a certified document is available at
the link provided. The recipient logs on to the web site to view the fax. Sending
via certified delivery requires the SecureDocs module.

* Send a regular or an encrypted PDF image instead of the regular TIFF image. A
regular PDF image is black and white and cannot be edited while an encrypted
PDF image is rendered in color as applicable and can be edited. Creating regular
PDF images requires the PDF module. Creating encrypted PDF images requires
the SecureDocs module.

Note: If your user account does not allow sending outbound emails, any fax
you send to an email address will fail.

To select a destination from a phonebook:

1. Click To, and the Phonebook dialog box opens.

FXNET240400-UFD-EN-01 FaxUtil User Guide 13



Chapter 3 Completing the fax information

Under Select Recipients, double-click an entry to add it to the Current
Recipients list. If you cannot see the entry, type a complete or partial ID in the
Type ID or select from list box.

Repeat the above step as needed to add multiple recipients, and then click OK.
The addressing information (fax, email, or SMS) associated with the selected
entry or entries appears in the To line of the New Fax window. If you selected
multiple entries, the number of fax recipients appears as fax(n), e-mail(n), or
SMS(n) where n is the number of recipients.

To enter a fax number destination:

In the Name box, enter the name of the recipient.
Click the Fax shortcut menu, and then select Fax.

In the To box, enter the fax number. You can enter the number with or without
hyphens, parentheses, or spaces.

To use post-dialing, enter an ampersand (&) followed by a sequence of DTMF

digits. The post-dial string can include PSTN telephony characters such as 0-9,
#, %, and a comma, but not p, t, w, and !. The digits will be dialed as soon as the
SR140 receives a SIP 183 or SIP 200 response code or a H323 message from the

gateway.

Note: The Quick Search feature can display a maximum of 250 entries
when searching from the To Fax field in FaxUtil. Use the search options in
Phonebook to find and select a fax number.

To enter optional contact information for the recipient, click the More button. In
the More Fax Addressing dialog box, under To, you can enter a voice number,
company, city, or state.

To enter an email destination:

L

In the Name box, enter the name of the recipient.
Click the Fax shortcut menu, and then select E-mail.
In the To box, enter the email address.

To enter optional contact information for the recipient, click the More button. In
the More Fax Addressing dialog box, under To, you can enter a voice number,
company, city, or state.

14

OpenText™ Fax FXNET240400-UFD-EN-01



3.2. Entering notes to appear on the cover sheet

3.2 Entering notes to appear on the cover sheet

You can add notes that will appear on the cover sheet of the fax.

When you send to an SMS number, the recipient will receive only the text from these
cover sheet notes.

To add notes to the cover sheet:

¢ In the Message box, type the text that should appear on the cover sheet of the
fax. You can enter 21 lines of text. SMS text is limited to 160 characters.

3.3 Attaching files or library documents

You can attach the following types of documents to a fax:

¢ Files that need to be converted to fax format.

Note: To broadcast a fax to a large number of recipients quickly, attach
library documents instead of files.

If sending a file to an email address, you can send it in its native format instead
of fax format.

¢ Library documents that are already converted.

* Documents from a TWAIN32-compliant scanner.

The attachments are appended after the cover sheet in the order shown in this list.
You can change the order until the fax is submitted.

To attach a file

1. Drag and drop the file, or click ﬂ

2.  Browse to where the file is located.

3. Select the file, and then click Attach. The file appears in the list of
attachments.

To attach a library document

. 0]
1. Click .

2. Click the library document, and then click OK. The library document
appears in the list of attachments.

FXNET240400-UFD-EN-01 FaxUtil User Guide 15



Chapter 3 Completing the fax information

To scan a document from a scanner

1. Click é

2. In the Document Scan window, in the Current Scanner box, select the
scanner. Click Start Scan.

3. Select the relevant details and click Scan.

4. Click OK. The scanned document appears in the list of attachments.

To change the order of the attachments
Under Attachments, click the row of the attachment you want to move, and then

click ﬂ or ﬂ

To exclude an attached file from being converted to fax format
This option is only available if you are sending the fax to an email destination.

Under Attachments, in the row of the attachment, select the check box in the
Native column.

To render an attached file as the body of your email
This option is only available if sending to an email destination.

When you select to render an attached file as the body of your email, the file is
excluded from conversion to fax format. The email software will use the first file
type it supports as the body of your email and ignore any additional files
designated as alternate body pages.

1. Attach one or multiple alternate body files. These should differ only in file
format and formatting, not in content.

If attaching multiple alternate body files, make sure that the least frequently
supported body type (such as RTF) appears first (at the top of the list) and
the most frequently supported body type (such as TXT) last.

2. Inthe row for each alternate body file attachment, select the check box in
the Alternate body column.

To delete an attachment

Under Attachments, click the row of the attachment, and then click

To view an attachment

Under Attachments, click the row of the attachment, and then click i

16
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3.4. Customizing cover sheet options

3.4 Customizing cover sheet options

Click the Cover Sheet tab. Your user account permissions determine if you can
change the settings set by your fax administrator.

To add a cover sheet:

¢ Select the Include cover sheet check box.
To preview a cover sheet file:

e (lick View.

To select a different cover sheet file:

* Under Include cover sheet, select the file. You can change cover sheet files only if
you have been granted permission to do so by the fax administrator.

To customize your contact information on the cover sheet:

* Click the More button. In the More Fax Addressing dialog box, under From,
enter your contact information as you want it to appear on the cover sheet.

3.5 Assigning billing codes

Billing codes can identify the sender, the recipient, or the content of documents.
They do not typically appear in the fax but are stored with the fax on the server.

Your user account permissions determine whether you are required to enter billing
codes—either one or two—and whether you can select them from a list. By default
the codes are labeled Account and Matter, but may be named differently.

To enter billing codes:

1. Click the Billing tab, enter a code in the Account box, in the Matter box, or
both. You may also be able to select billing codes from a list:

2. Click the Lookup button, and then click OpenText Fax Billing Table on the
shortcut menu. The Billing Code Lookup dialog box opens.

3. Inthe Account, Matter, or Description box, enter the characters by which to
search.

4. Click Search, and then double-click a billing code to select it.

FXNET240400-UFD-EN-01 FaxUtil User Guide 17



Chapter 3 Completing the fax information

3.6

3.7

Entering comments about the fax

You may wish to associate notes or comments with the fax. Comments will appear
in the fax mailbox in the Comments column and in the fax history. Comments are
not sent to the recipient.

To add comments for your own use, click the Comment tab, and enter a comment.

Selecting options for converting documents

Click the Conversion tab. Your user account permissions determine if you can
change the settings set by your fax administrator.

To adjust the quality of the conversion:

The Conversion Bias setting determines whether the conversion of attachments is
optimized for images, text, both, or not at all.

* To use the setting selected by your administrator, select Use Server Default. If
the resulting quality does not meet your needs, you can try to improve it by
respectively selecting Optimize for Images, Optimize for Text, High Contrast
(optimize for both images and text), or None (do not optimize). You can use the
Hold for Preview option to check the quality of the conversion.

To convert documents to PDF:

When sending a fax, you may have the following PDF options if the OpenText Fax
server is configured to allow them:

* When sending to a fax number, the fax is sent in fax file format. If configured, a
PDF of the fax is stored on the OpenText Fax server, and you can view the PDF
image.

* When sending to an email address, you may have the option to send the fax in
PDF file format.

If you send password-protected PDF files, they are encrypted and are rendered in
color, as applicable.

The creation of PDF images requires the optional PDF module. For more
information, see the OpenText Fax - Administrator Guide (FXNET-AGD). The ability to
encrypt the PDF files requires the optional SecureDocs module. For more
information, see the OpenText Fax - SecureDocs Module Administrator Guide (FXNET-
ASD).

* Select the Create PDF image check box.

To password protect the PDF file, click PDF options, and the PDF Options
dialog box opens.

18

OpenText™ Fax FXNET240400-UFD-EN-01



3.8. Selecting transmission options

Require a password to open the document
The recipient can open the document. Select the check box, and enter the
password.

Restrict editing or printing of the document
The recipient can edit the PDF. Select the check box, and then select the
actions that the user can perform on the PDF.

Permission Password
Anyone with the permission password can open, print, and save the
document, change the editing permissions, and change the PDF passwords.
Select the Restrict editing or printing of the document check box, and enter
the password.

To apply an overlay form to the fax:

An overlay form, such as a letterhead, can be applied to the fax. Overlay forms are
fax images that superimpose over the fax to give it the appearance of having been
printed on a form prior to faxing.

1. Select the Use Form check box.

2. In the list, select the form.

To hold the fax for preview:

* To hold the fax in a status of Held for Preview until you release it to be sent, select
the Hold for preview checkbox.

3.8 Selecting transmission options

Click the Sending tab. Your user account permissions determine if you can change
the settings set by your fax administrator.

To send with Certified Delivery:

* For email destinations, you can send a link to the fax rather than the fax. You will
be notified when the fax has been viewed. Select the Certified Delivery check
box. Sending via Certified Delivery requires the SecureDocs module.

To use smart resume:

* Select the Smart resume check box to only resend the portion of the fax that
failed in case errors occur during transmission.

To delay sending until the cheap rates time defined in your FaxUtil options:

¢ Select the Use cheap rates check box. If the time has passed, the fax will be
delayed until tomorrow at the cheap rates time.

FXNET240400-UFD-EN-01 FaxUtil User Guide 19



Chapter 3 Completing the fax information

To change the cheap rates time:

¢ On the Tools menu, click Options, and in the Cheap Time box on the Other
Options tab, specify the time.

To delay sending until a specified date and time:

* Select the Delay send check box, and then specify the time and date in the boxes
below. If the date and time have passed, the fax will be queued to sent as soon as
possible.

To change the priority for sending the fax:
* In the Priority list, select one of the following:

— Normal to queue the fax in the order it is sent.
— Low to move the fax to the end of the send queue on the fax server.

— High to move the fax to the front of the send queue on the fax server. This
option is available if you have the appropriate permission.

To change the automatic deletion setting for the fax:
¢ In the Automatic Deletion list, select when to delete the fax from your mailbox:

— To never delete, click Never.
— To delete after the fax was successfully sent, click After Successfully Sent.

— To delete the fax independent of whether it is sent successfully, click Always.
To send a text notification about this fax to the recipient’s phone:
* In the Notification address box, enter the recipient's SMS number.
To enter an alternate fax number:

* In the Alternate fax box, enter the recipient's alternate fax number. This number
may appear on the fax cover sheet.

To restrict sending to a specific fax machine:

¢ In the Recipient fax ID box, enter the CSID of the receiving machine. If the ID
does not match, the fax is not sent. Leave blank to allow sending to any fax
machine.

20 OpenText™ Fax FXNET240400-UFD-EN-01



Chapter 4

Viewing

4.1

the fax list

You can customize how you view the fax list and what faxes appear in the list and
which data columns appear. In addition to customizing the list, you can search for
faxes using a simple search in a single column or an advanced search.

Managing fax folders

Faxes in your mailbox are organized in folders. Every mailbox includes the system
folders All and Main. You can create custom folders and nest folders within folders.
Independent of their location in other mailboxes, all faxes appear in the All folder.

You can move all or select faxes from one folder to another.

If you move the faxes to the Trash folder, you will be prompted to confirm their
deletion.

If the OpenText Fax Archive Module is in use, the Archive folder is available. The
folders All, Main, and Archive cannot be renamed, and they cannot contain other
folders.

To create a custom folder:
1. Depending on where you want to create the folder, do one of the following:

e (Click Main to create the folder on the same level as the Main folder.
e (lick a custom folder within which to create the folder.
2. On the File menu, point to Folder, and then click New.

3. Inthe New Folder box, type a name, and then click OK.

To rename a custom folder:

1. Right-click the folder, and then click Rename.

2. Inthe New Folder Name box, type the new name, and then click OK.
To delete a custom folder:

1. Right-click the folder, and then click Delete folder contents. Click OK to
confirm that you want to delete the contents of the folder.

2. Right-click the folder, and then click Delete folder. Click OK to confirm that
you want to delete the folder.
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4.2

Depending on options specified by you or the administrator, the folder and its
contents are either permanently deleted or moved to Trash. See “Deleting
faxes” on page 37.

To move selected faxes to another folder:
* Select the faxes in the list, and then do one of the following:

— Drag the selection to the appropriate folder in the left pane.

— Right-click the selection, and on the shortcut menu, click Move to folder. In
the list of folders, select the destination folder.

To move all faxes in one folder to another:

1. Right-click a folder other than All, and on the shortcut menu, click Move folder
contents.

2. In the list of folders, select the destination folder, and then click OK. All faxes in
a completed status will be moved.

Note: Faxes in any other status may not get moved. Faxes are completed
when they have either been sent successfully or failed to send and will not
be retried.

To work with faxes in the Archive folder:

The Archive folder is available if the OpenText Fax Archive Module is in use. The
folder contains your faxes that have been archived according to criteria determined
by your system administrator.

* You can use simple or advanced search to find faxes in the Archive folder.
* You can view, print, download, and save copies of archived faxes.
¢  You cannot delete archived faxes or move them to another folder.

* When viewing a fax, you cannot make any changes or annotations. Pages can be
rotated, but the setting is not saved.

Customizing the appearance of the fax list

To change how many faxes appear per page:
1. Inthe Show <n> faxes box, select 25, 50, 75, 100, or 250.

2. To view the next or previous page of faxes, click the left or right arrow next to
the Page box.

To sort your faxes:

1. Click a column header in the fax list to sort the list in ascending order on data in
that column.
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4.3. Customizing the contents of the fax list

2. To sort the list in descending order, click the same column header again.
To move columns:

1. Click the column header of the column you want to move.

2. Drag and drop the column to the new position. When you drag the column
header, a vertical bar shows the position of the column.

4.3 Customizing the contents of the fax list

You can view all saved faxes for the selected user or users or show only a subset of
faxes. If you apply a filter to the list, the selected filter appears below the tool bar
after the name of the selected folder.

You can also remove or add columns to customize which data appears in the list.
To view all faxes:
¢ On the List menu, click Full List.

To apply a filter to view only a subset of faxes:
1.  On the List menu, click one of the following;:

* Sent Faxes to show only sent faxes.

* Received Faxes to show only received faxes.

¢ In-process Faxes to show only faxes currently being sent.

* New Faxes to show only faxes that have not yet been viewed.

* Received and In-process Faxes to show faxes that have been received and
those that are currently being sent.

* Needing Approval to show only faxes that need approval.

2. If you are an administrator viewing the list in administrative mode, you can
apply an additional filter. See “Viewing fax mailboxes in administrative mode”
on page 29.

To add or remove columns:

1. Right-click any column header in the list.

2. Point to View. All items with a check mark appear as columns in the list.
3. Do one of the following:

e (lick a selected item to remove it.
¢ C(lick an unselected item to add it.

e To restore the default view, click Reset to Defaults.
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4.4 Searching the fax list (simple)

You can search for faxes by text in the information about the fax and in the text of

the fax.

To perform a simple search:

1. In the Search box, enter text by which to search. You have the following
options.

Comment — Enter text to search the comments about the fax.

To name or from name - Enter a full or part of the recipient or sender name.
To company — Enter a full or part of the recipient company name.

To fax number — Enter a full or part of the destination fax number.

To voice number — Enter a full or part of the voice telephone number of the
recipient.

To city or state — Enter the full or part of the city or state of the recipient.
Billing code 1 or 2 — Enter a full or part of the billing code.

Remote ID — Enter a full or part of the name or telephone number of the
sending fax machine.

Company telephone number — Enter a full or part of the telephone number
for the sending company.

Unique ID - Enter a full or part of the unique ID of the fax.
OpenText Fax Cloud Connect job ID — Enter a full or part of the job ID.
ANI - Enter a full or part of an ANI code.

Date created — Enter a full or part of the date that the fax was created. If you
enter a date surrounded by quotation marks, the system will search for the
exact text within the quotation marks.

Text — If the OCR Module is in use and the fax has been converted to text,
then you can enter any text to find within that text.

Metadata — In the left pane, click the workflow folder in which to search. In
the Search box, enter the metadata text for which to search.

2. To start a new search, type new text in the Search box.

3. To clear the search, delete the text from the Search box.
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4.5. Searching the fax list (advanced)

4.5 Searching the fax list (advanced)

You can search for text in multiple fields while applying filters.

Note: Advanced search and administrative mode are mutually exclusive.
Starting advanced search deselects administrative mode.

To perform an advanced search:

1. Click Advanced Search, and the Advanced Search dialog box opens.

2. On the Filter tab, specify the filters to apply. See “Specifying the filters”
on page 26.

3. On the Find tab, in each box for a field you want to search, enter the search text.
See “Entering text for which to search” on page 28.

4. Click Search.
To clear the search:
¢ In the Advanced Search dialog box, click Reset.

To save the search:

1. Inthe Advanced Search dialog box, click Save. The Save Advanced Search
Parameters dialog box opens.

2.  Enter the name for the filter, and click OK.

To use a filter that you have saved:

1. Inthe Advanced Search dialog box, click Load. The Load Advanced Search
Parameters dialog box opens.

2. Select the filter, and click OK. The parameters appear in the Advanced Search
dialog box. Click Search.

To modify a filter that you have saved:

1. Inthe Advanced Search dialog box, click Load. The Load Advanced Search
Parameters dialog box opens.

2. Select the filter, and click OK. The parameters appear in the Advanced Search
dialog box, and you can modify them.

3. Click Save. The Save Advanced Search Parameters dialog box opens.

4. Enter a new name for the filter, and click OK.
To delete a filter that you have saved:

1. Inthe Advanced Search dialog box, click Delete. The Delete Saved Search
Parameters dialog box opens.
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2. Select the filter, and click OK.

4.6 Specifying the filters

The default filter settings include your own received and sent faxes, including
viewed and printed ones, independent of the method of delivery and status.

To open the filter settings:

e C(Click the Filter tab.

To search a specific folder in your mailbox:

e With the My own faxes check box selected, next to the Folder box, click EI
Select the folder, and then click OK.

To exclude your own fax mailbox:

® (Clear the My own faxes check box, and under Other Users and Groups, specify
the mailboxes to search.

To search other user's mailboxes:
Do one of the following:

* To search all mailboxes to which you have access, click All users available to me.

¢ To search only mailboxes of specific users, click Only these users, and then select
users, groups, or both:

— Next to the Users box, click EI In the list, select a user to add, and then click
Add. Repeat as needed, and then click OK.

— Next to the Groups box, click EI In the list, select a group to add, and then
click Add. Repeat as needed, and then click OK.

To search for faxes in OpenText Fax Archive:

1. If the OpenText Fax Archive Module is in use, you can include archived faxes in
the search. Select the Archived faxes check box.

2. To view the search results, click the Current Faxes or the Archived Faxes tab, as
shown in the following example:
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4.6. Specifying the filters
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To limit the faxes by date or time:

Do one of the following:

To include only faxes sent since a specific date or time, select the Start Date and
Time check box, and then select a date and time.

To include only faxes sent before a specific date or time, select the End Date and
Time check box, and then select a date and time.

To include only faxes sent in a specific time frame, select the Start Date and Time
and the End Date and Time check boxes, and select a date and time for each.

To customize the Workflow, Delivery, and Status filters:

1.

5.

Under Workflow, select the Received and Sent, Received only, or Sent only
check box.

To include faxes based on whether they have been viewed, select Viewed, Not
viewed, or Any view condition.

To include faxes based on whether they have been printed, select Printed, Not
printed, or Any print condition.

Under Delivery, clear the check boxes of the delivery methods you want to
exclude. By default Fax, Email, SMS, and Certified Delivery are selected.

Under Status, clear the check box of each status you want to exclude.

To restore the default selections:

Click Reset.
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4.7 Entering text for which to search

4.8

To open the Find settings:

e (Click the Find tab.

To enter the search text:

¢ Enter text by which to search in any of the following boxes:

Fax Number/E-mail — Enter a full or partial fax number or email address.
To/From — Enter a full or partial recipient or sender name.

To Voice Number — Enter a full or partial recipient voice number.

To Company — Enter a full or partial recipient company name.

To City/State — Enter full or partial city or state information for the recipient.
Account - Enter a full or partial billing code 1.

Matter — Enter a full or partial billing code 2.

Comment — Enter a full or partial comment.

OCR Text - If the OCR Module is in use and the fax has been converted to
text, then you can enter any text to find within that text.

Workflow Data - Enter text from data entered in workflow fields.
CSID - Enter a full or partial CSID.

ANI - Enter a full or partial ANI code.

OpenText Fax Cloud Connect Job ID — Enter a full or partial job ID.
Fax Unique ID - Enter a full or partial unique ID.

Fax Handle - Exact match — Enter a full fax handle.

To restore the default entries:

e (lick Reset.

Viewing other users' mailboxes

Fax administrators, group monitors, and delegates can view other users' fax lists. In
this case, the Other Users option appears below your own mailbox folders.

To browse to another user's mailbox:

1.
2.

In the left pane, expand Other Users.

Browse to the other user, and then click the folder you want to view. The
owner's username appears at the top of the folder list.
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4.9. Viewing fax mailboxes in administrative mode

To search for another user's mailbox:

1. On the Tools menu, click Find User.

2. In the Search String box, type the string for which to search. You can enter an
exact user ID, an exact routing code, or a full or partial user name.

3.  Under Search Field, click whether the search string is a User ID, a User Name,
or a User Fax Number/Routing Code.

4.  Click Find. If more than one user name matches a partial user name entry, only
the first occurrence is shown.

To refresh the mailbox settings and folders for another user:

1. In the left pane, expand Other Users.

2. Browse to the other user. Right-click the selection and, on the shortcut menu,
click Refresh User.

To refresh the mailbox settings and folders for a user group:
1. In the left pane, expand Other Users.

2. Browse to the user group. Right-click the selection and, on the shortcut menu,
click Refresh All Users.

4.9 Viewing fax mailboxes in administrative mode

As a fax administrator or a group monitor you can view the content of all fax
mailboxes you administer at one time, apply filters specific to your administrative
role, and quickly access all faxes requiring approval.

To enable administrative mode:

1. On the List menu, select Administrative Mode. A checkmark appears next to
Administrative Mode.

2. To return to normal mode, click Administrative Mode. The checkmark is
removed.

To view a list of all faxes awaiting approval:
1. Enable administrative mode.

2. On the List menu, click Needing Approval.
Using the administrative mode filters:

1. Enable administrative mode.

2. On the List menu, point to Administrative Mode List, and then click one of the
following status filters:
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Information Incomplete — Display faxes that are waiting for fax conversion.

Waiting for Conversion — Display faxes that are waiting to be converted to
fax format.

In Conversion — Display faxes that are currently in conversion to fax format.
Sending — Display faxes that are currently being transmitted.
OK - Display faxes that have sent without errors.

Aborted with error condition — Display faxes that have sent but reported
one oOr more errors.

Error condition - will retry — Display faxes that have failed to send due to
errors, but will be retried after a short interval.

Waiting to be Sent — Display faxes that are converted to fax format and are
waiting to enter the transmission queue.

Scheduled to be Send - Display faxes that are converted to fax format and
are waiting in the queue to be sent.

Held for Preview — Display faxes that are waiting in your mailbox for your
review before being sent.

Waiting for Attachment — Display faxes that are waiting to pick up a file
attachment.

Attention Status — Display faxes that are waiting to send because some
attention is required.

Printing — Display faxes that are currently being automatically printed.

Queued for Printing — Display faxes that are waiting to enter the print
queue.

OCR in Progress — Display faxes that are being converted to text using
Optical Character Recognition (OCR) technology.

Queued for OCR - Display faxes that are waiting to be converted to text.

Validating — Display faxes that are waiting for approval by a supervisor
before being sent.

Needs Approval — Display faxes that are waiting for approval by a delegate
who has the delegate permissions Can view faxes or Can view first page of
received faxes, and Can approve faxes.

Duplicate — Display duplicate faxes.

Paper Fax Record - Display faxes that have been manually recorded.
Typically these are faxes that were not received via OpenText Fax, for
example, on a conventional fax machine.

Print Operation Failed — Display faxes that failed to automatically print.
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Chapter 5

Viewing and handling sent and received faxes

5.1 Viewing the fax, the history, and the OCR
versions

You can view the content of a fax and the history of fax activity. The fax history is
created and added to as activity occurs on the fax.

Note: If an administrator or group monitor disapproved a fax held for
preview, the history may include a note explaining the disapproval.

Depending on your user permissions, you may be able to view prior saved versions
of fax pages. Prior versions exist for saved annotated fax pages, fax pages to which
an overlay form was applied, and for stamped fax pages.

To preview a fax:

¢ In the fax list, click the fax. The fax appears in the preview pane.

To view the whole page of the fax, click L—=

To zoom to the width of the page, click

To view the previous or the next page, click < or > .

— To move to the previous or the next fax, click # or %*.
To turn the preview pane on or off:
¢  On the Tools menu, click Preview Pane.
To open a fax to view it:

* In the fax list, select the fax, and then click View. The fax is shown one page at a
time.

— To view the whole page of the fax, click L=

— To zoom to the width of the page, click

— To view thumbnail images of each page of the fax, click .
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— To view the previous or the next page, click ( or ) .

— To move to the previous or the next fax, click # or %*.
To show the fax history:
1. Inthe fax list, do one of the following;:

¢ To view both the fax and its history, open the fax, and then click the History
tab.

* To view the fax history only, right-click the fax, click Show History.
* To view a composite history of multiple faxes, select the faxes, right-click the

selection, and then click Show History.

Note: The composite history cannot be filtered, printed, saved, or
opened in Notepad.

2. Under Show, clear the check boxes of the items you do not want to include and
select those you do, and then click Apply:

e Transmission shows when the fax was received or sent and details about the
transmission.

e Conversion shows when and how a document was converted to fax format
or a fax to text (OCR).

* Handling shows when the fax was forwarded or routed and to which
recipient.

* General shows when the fax was printed, viewed, and annotated, and by
whom.

To print the fax history, save it as a text file, or open it in Notepad:
1.  Show the fax history.

2. Do any of the following:

* To print the history, click = , and then click Print or Server Print, if
available. Select a printer and specify any special print options.

* To save the history to a text file, on the File menu, click Save or Save As.
* To open the history in Notepad, click I__I‘;1
To view previously saved versions of a fax page:

1. Open the fax and go to the fax page.

2. Click the Prior Versions tab. If prior versions are available, the prior versions
for the page appear in a list, where each version is identified by date and time,
with the most recent prior version appearing on top.
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5.2. Marking faxes as unviewed

3.  Click the date and time of the version you want to view.

To show and open OCR text in Notepad if available:

1. Open a received fax that has been converted to text ().
2. Click the OCR tab.

3. To open the text in Notepad, click |__I"'-'1

5.2 Marking faxes as unviewed

When a fax is first received and has not yet been viewed, its entry appears bold in
the fax list. Viewing the fax removes the bold formatting.

You can reapply the bold formatting without triggering any of the actions related to
viewing a fax for the first time. When you do so, "Unviewed Record" and "Marked
as unviewed by user ID" are added to the fax history.

To mark one or more faxes as unviewed:

1. In the fax list, select the received fax or faxes.

2. Right-click the selection, and on the shortcut menu, point to Status, and then
click Mark as Unviewed.

5.3 Saving or printing a confirmation page

You can save or print a confirmation page that indicates that if the fax was
successfully sent or not.

To save or print a confirmation page:
1. Open the fax or click a fax in the fax list.

2. On the Fax menu, click Show confirmation page.

3. You can now save or print the confirmation page.

* To save the page, click H, select a location and file format, and then click
Save.

=)

¢ To print the page, click , select the printer, and then click Print.
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5.4

5.5

Adding comments to a fax

You can add comments to received and to sent faxes. When you select multiple
faxes, the comment is appended if comments exist. If you select a single fax, the
existing comment is shown and can be modified or deleted.

When exposed in the Comment column in the fax list, truncated comments are
indicated by ellipses (...).

To add or append a comment to multiple faxes:
In the fax list, select the faxes.
On the Fax menu, click Add Comment.

In the Comments for your Records box, type the comment.

Ll

Click OK. The comment will be appended to any existing comments.
To add, modify, or delete a comment for a single fax:
1. In the fax list, select the fax.

2. On the Fax menu, click Add Comment. The existing comment appears in the
Comments for your Records box.

3. Asneeded, change the comment text, replace, or delete it.
4. Click OK.

To view comments in the fax list:

1.  On the List menu, point to View, and then click Comment.

2. Toview a comment that is truncated, move the pointer over the comment.

Annotating a fax

Depending on your user permissions, you may be able to add text and graphic
elements to a fax page. Each time you save a page you annotated:

¢ The annotations become part of the image of the page and cannot be deleted or
edited.

¢ A version of the page is created, identified by the date and time it was saved.

Depending on your user permissions, you may be able to view prior versions of
saved fax pages. Any prior versions of a page appear on the Prior Versions tab while
the last saved version appears on the Image tab. See “Viewing the fax, the history,
and the OCR versions” on page 31.

To add, edit, or delete an annotation:

e C(Click Q\\l to edit or delete annotations.
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5.5. Annotating a fax

To delete or move a graphic annotation:
* Click the Edit Annotation button and then click on the annotation object. The
object is surrounded with a dashed gray line. Click and drag the object to move it

on the page, or right-click and select Delete to delete the object.

To edit a text annotation:

* Right-click and select Edit. This opens a dialog box for text entry. Type the text
you want and click OK. If you want to add a carriage return to the text in this
dialog box, press CTRL+ENTER.

The annotation tools:

$ Pan image.

D Draw a selection box.
i
Q& Edit annotation

Zoom to current selection.

1A

Draw a rectangle (outline).

Draw a rectangle (filled).

Draw an ellipse (outline).

Draw an ellipse (filled).

® O B O

Add text.

>
)

Draw line.

N

Draw a freehand line. Freehand lines follow the movement of your pointer.

v

Place an image from a file or from a library of images (also known as "stamps").

To place an image, browse to the folder containing the image, you can also
drag and drop the image from the folder.
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5.6

5.7

Sending a fax via email

You can attach a sent or received fax to an email message. You can select a fax in the
fax list or send a fax you are currently viewing.

To attach a fax from the fax list:

1. In the fax list, select the fax.

2. On the Fax menu, click Send via-email.

e If Outlook is installed on your computer, then an email message will appear
with the selected file attached. Enter the destination, and send the message.

e If Outlook is not installed on your computer, then the Send as Email
window opens. Enter the destination, and then click OK. The fax will be sent
as an attachment to the email message.

To attach a fax you are viewing:
¢  On the File menu, click Send via e-mail.

— If Outlook is installed on your computer, then an email message will appear
with the selected file attached. Enter the destination, and send the message.

— If Outlook is not installed on your computer, then the Send as Email window
opens. Enter the destination, and then click OK. The fax will be sent as an
attachment to the email message.

Printing faxes

The option to print to a server printer is only available if your user account allows
printing to a fax server printer.

If your user account allows printing to a fax server printer, you can set up FaxUtil to
print sent and received faxes automatically. To configure automatic printing, see
“Defining sending preferences” on page 53 and “Defining receiving preferences”

on page 54.

To print from the fax list:
1. In the fax list, select the fax or faxes.
2. On the Fax menu, click Print or Server Print if available.

3. Select a printer or fax server printer, specify any special print options, and then
respectively click Print or OK.

To print a fax you are viewing:

1. Click o , and then click Print or Server Print if available.
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5.8. Deleting faxes

2. Select a printer or fax server printer, specify any special print options, and then
respectively click Print or OK.

5.8 Deleting faxes

Deleted faxes are either deleted immediately or moved to the Trash folder. If you
use the Trash folder for deleted faxes, you can specify that it be emptied whenever
you exit FaxUtil.

To use the Trash folder for deleted faxes:

1.  On the Tools menu, click Options.

2. On the Other Options tab, select the Use Trash Folder When Deleting check
box.

3. If the Trash folder should be automatically emptied and the faxes permanently
deleted when you exit FaxUtil, select the Empty Trash Folder on Exit check box.

To delete a fax you are currently viewing:

1. Click Ej

2. Click Yes to confirm the deletion.

To delete multiple faxes:

1. Inthe fax list, select the fax or faxes, and on the Fax menu, click Delete. To
bypass the Trash folder if used, press SHIFT+DELETE.

2. Click Yes to confirm the deletion.

To delete all faxes in a folder:

1. Right-click the folder, and then click Delete folder contents.

2. Click Yes to confirm the deletion of the n number of faxes in the folder.
To delete all files from Trash:

1. Right-click Trash, and then click Empty Trash.

2. Click OK to confirm that you want to permanently delete the contents of the
Trash folder.
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5.9

Combining or splitting faxes

You can combine multiple faxes into a multi-page fax or split a single multi-page fax
into multiple faxes.

To combine multiple faxes and send in a single fax:

1.
2.

In the fax list, select the faxes, and then click Combine.

As needed, in the Faxes to combine list, select a fax you want to move, delete,
or view, and then click one of the following :

. ﬂ or ﬂ to move the selected fax up or down the list,.
X

. to delete the selected fax.

Q

e ___lto view the selected fax.

Under Pages to Combine, click All Pages to include all pages, or click Page
Range, and then indicate the first and last page to include in the From and To
boxes.

Click Combine.

In the New Fax window enter the destination —typically required are recipient
name, destination type, and a fax number or email address—and as needed,
add billing codes, cover sheet notes, and specify other processing options.

Click OK.
If required information is missing, do one of the following:

e To send the fax now, click Cancel, fill in the information, and then click OK.

e To fill in the information later and hold the fax in a status of Information
Incomplete until then, click OK.

To split a fax into multiple faxes:

1.
2.

In the fax list select a multi-page fax, and then click Split.
The Number of body pages in the original fax appears above the text box.

In the text box, enter a page range for each fax, separating the page ranges by
comma.

Example: To split a fax that has 10 body pages into two faxes with 5 pages each, enter
"1-5,6-10."

To retain the original file in the mailbox after the split, select the Keep Original
Fax check box.
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5. Click OK. A message show how many faxes were created. Click OK. The faxes
appear in the mailbox.

5.10 Entering metadata for a fax in a workflow

If you are responsible for entering metadata for a fax in a workflow, then one or
more workflows appear in the Workflows folder.

To enter metadata for a fax in a workflow:

1. Click the Workflows folder, and the list of workflows appears in the left pane.

2. Click the workflow, and the list of faxes for tagging appears in the right pane. If
a fax is locked by another OpenText Fax user, then the user ID appears in the
Availability column.

3.  Select the fax, and then click View. The fax opens in the viewer and is locked so
that other users cannot open it.

4. The list of metadata appears in the right pane. Enter the metadata in each field.
Metadata extracted from the faxed form appears highlighted in yellow in the

right pane. If data appears with the L icon, then the data is a result of
intelligent matching. Verify and make corrections to all of the extracted text
before submitting the workflow.

If OpenText Fax Intelligent Workflows are configured, then when you are
finished reviewing the extracted data, click Save under Workflow Template.

You can edit the metadata from any previous workflow through which the fax
has flowed. If data fails validation, an error message appears, and you cannot
save or complete the workflow.

If your system administrator has not configured your user account for entering
metadata in the workflow, then the list of metadata will not appear in the right
pane.

5. When the required data is entered, click one of the following options if they
appear:

* If you wish to finish entering metadata at a later time, click Save and keep.
e If you are finished entering metadata, click Complete workflow.

* If you wish to remove the fax from the workflow, click Remove fax from
workflow. When the fax is removed from the workflow, any metadata that
you have entered will be discarded.

* If you wish to divert the fax from the workflow, click Exception. The fax will
be diverted to the exception workflow that is defined by your system
administrator.

6. To enter a comment that will appear in the history of the fax, enter text in the
Comment for fax history box. Comments are not available if you click Save and
keep.
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5.1

7.

Do one of the following:

¢ To save your entries, click Save.

* To cancel your entries, click Revert.

To view metadata for a fax in a workflow:

1.

Click the Workflows folder, and then open folder that contains the faxes with
the metadata you wish to view.

Right-click any column header in the list.

On the shortcut menu, click View, and then click Workflows. A column for
each metadata value appears in the fax list with the label
WorkflowName:DataName.

If data fails validation, it appears with a light red background.

If a fax was processed with OpenText Fax Intelligent Workflows, then captured
data is shown with a light yellow background. This includes non-required fields
for which no data was captured. If no data was found by OpenText Fax
Intelligent Workflows for a required field, then the grid cell is empty and has a
light red background.

To search for specific metadata, see “Searching the fax list (simple)” on page 24.

Converting received faxes to text using OCR

You can convert received fax images to text using optical character recognition
(OCR) where the resulting text file is saved as an attachment of the original fax. The
OCR option is available if the fax server is configured for OCR and you have the
appropriate user permission. Only images of printed text are converted.

You also can have all received faxes automatically converted. See “Defining
receiving preferences” on page 54.

To perform OCR on individual faxes:

1.

2.

In the fax list, select one or more faxes.
Click OCR.
Select the file type and format for the output files.

For a single fax, click All Pages to OCR all pages in the fax, or click Page Range
and then indicate the first and last page to OCR.

Click OK.
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5.12 Creating a record for a paper fax

If your organization requires that all faxes be recorded in the fax server for reporting
purposes, you can manually create a record of a fax that is sent or received outside
of OpenText Fax. For example, a fax sent or received from a paper fax machine.

To create a record for a paper fax:

1. On the Fax menu, click Record Manual Fax.

2. In the New Fax window, complete the entries that are necessary for the fax
record. See “Completing the fax information” on page 13.

3. To indicate if the fax was sent or received, click Sent or Received.
4. To indicate the number of pages in the fax, enter the number in the Pages box.

5. Click OK. The fax appears in the fax list with the status Paper Fax Record.

5.13 Submitting faxes for external processing

Use this option to submit faxes for processing with the XML Generator Module or
Connector for IBM FileNet.

The fax will be deleted from your mailbox and moved to a location specified for the
XML Generator Module or Connector for IBM FileNet.

If external processing is not enabled, the fax will not be submitted.
To submit faxes from the fax list for external processing:

1. Open the fax, or select the fax or faxes in the fax list.

2. On the Fax menu, click Submit for external processing. The fax is deleted from
the mailbox after it is submitted, and this may take a few minutes.
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Creating and using phonebooks

Depending on your user account configuration, you can store fax recipient
information in a OpenText Fax phonebook and link to existing ODBC, LDAP, or
MAPI contact lists.

6.1 Creating a personal OpenText Fax phonebook

Your OpenText Fax phonebook can include entries for individual fax recipients and
groups of fax recipients.

To open your OpenText Fax phonebook:

You can open the phonebook using any of the following ways:
1. Click Tools > Phonebook.

2. From your mailbox, click Phonebook.

The Phonebook window opens.

6.1.1 Creating OpenText Fax phonebook entries

To create or edit an individual entry:
1. In the Phonebook window, do one of the following:

a. Click New Entry.
b. Click an individual entry in the list, and then click Edit Entry.

2. Inthe ID box, type an ID for the entry.

3. Under Address, enter addressing information for the recipient; such as a name,
a destination type, and address or a number (SMS or Fax).

4. Under Other, enter optional contact information, such as a secondary fax
number, voice numbers, and the recipient's fax id.

5. Under Options, select any of the following check boxes:

¢ Published: If selected, other OpenText Fax users can view the item.
* Read Only: If selected, only the owner can modify the item.

* Externally available: If selected, the item is available to applications other
than OpenText Fax software.

* Hidden on cover sheet CC list: If selected, the item does not appear in the
CC list on the cover sheet.
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6.1.2

6.

7.

Under Billing Information, enter billing codes and notes you want to assign to
all faxes sent to this recipient.

Click OK. The new entry appears as an individual entry in your phonebook list.

To create or edit a group entry:

A group phonebook entry can consist of both individual and group entries.

1.

5.

In the Phonebook window, do one of the following:

* Click New Group.
¢ C(lick a group entry in the list, and then click Edit Entry.

In the ID field, enter an ID for the group.

Select any of the following check boxes to specify who can view and edit this
group phonebook entry.

* Published: If selected, other OpenText Fax users can view this phonebook
item.

* Read Only: If selected, only the owner can modify this phonebook item.

* Externally available: If selected, this phonebook item is available to
applications other than OpenText Fax software.

In the box on the left, select all individual and group items you want to add to
the group, and then click the right arrow to move them to the Group Members
box.

Click OK. The group appears in your phonebook list.

Importing phonebook entries

To load another user's public phonebook entries:

1.
2.

4.

In the Phonebook window, click Other Users.

In the Search for Users box, enter a full or partial user name or a OpenText Fax
user ID, and then click Search.

Select the user, and then click Load. Any public entries from this user's
phonebook appear in your OpenText Fax phonebook list.

indicates if a user account is disabled, i if it is unprotected.

Repeat to load public phonebook entries from another user.

To import entries from a text file:

If your user account permission allows creating and editing phonebooks, you can
import entries into your personal phonebook from a specially formatted text file.
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6.2. Creating a text file to import

* To create the import file, see “Creating a text file to import” on page 45.

e To import the file, see “Importing entries from a text file” on page 47.

6.1.3 Deleting OpenText Fax phonebook entries

To delete an entry:
1. In the Phonebook window, in the list, click the entry.

2. Click Delete Entry, and then click Yes to confirm the deletion.

6.1.4 Printing OpenText Fax phonebook entries

To print all or select phonebook entries:

1. Click Phonebook.

2. To print all entries in the phonebook, click Print. Otherwise select the entries in
the list, and then click Print Selected.

3.  Select the printer and specify any other print settings, and then click Print.

6.2 Creating a text file to import

The import file can be generated by an external source such as a contact database
manager, exported from another OpenText Fax phonebook, or generated by the
OpenText Fax PhnPrint administrative utility. For information about PhnPrint, see
the OpenText Fax - Administrative Utilities Guide (FXNET-AWU).

The file to import must be a comma-, tab-, or space-delimited ASCII text file where:

¢ The first line is made up of the OpenText Fax field names shown in the table
below. When exporting from an existing source, map each field name to the
corresponding OpenText Fax name.

¢ Each phonebook record is separated from the next by a line break.

e Each field is separated from the next by a comma, tab, or space, depending on
the selected format.

e The field values in each record appear in the same order as the corresponding
field names on the first line.

* Each blank field value appears as a single space surrounded by quotation marks

).

e If quotation marks are used to surround any field name or field value, they must
be used for all fields in the file.

The following table lists each of the valid phonebook entry fields.
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Field name Max length Description

1D 17 A unique ID used only to reference the phonebook
entry. It never appears on the fax.

Name 59 The recipient’s name as it will appear on the fax
cover sheet.

Company 59 The recipient’s company name as it will appear on
the fax cover sheet.

Address 59 The recipient’s address as it will appear on the fax
cover sheet.

CityState 59 The recipient’s city and state as they will appear on
the fax cover sheet.

Fax1 31 The recipient’s primary fax number. This is used
when dialing the fax destination and may appear
on the fax cover sheet.

Fax2 31 The recipient’s alternate fax number. This is used
when dialing the fax destination and may appear
on the fax cover sheet.

Voicel 31 The recipient’s primary voice number as it will
appear on the fax cover sheet.

Voice2 31 The recipient’s alternate voice number as it will
appear on the fax cover sheet.

FaxID The recipient's fax ID.

BillCodel 17 A code associated with the recipient used for
billing or tracking purposes. It never appears on
the fax.

BillCode2 17 An additional code associated with the recipient
used for billing or tracking purposes. It never
appears on the fax.

Notes 128 Any additional information about the recipient.
This will not appear on the fax and is for your
information only.

Example: The following shows the first three lines and first three fields of an import file.
Instead of (...), a usable import file would include all field names listed in the table and field
values for each. For an example of a blank field value, see the value for Company in the

second record.

"ID","Name","Company",(...)

"Jan","Jan Smith","First Company" (...)

"Reddy","Reddy Patel"," "/(...)
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6.3 Importing entries from a text file

To import entries from a text file:

1.

2.

On the Tools menu, click Phonebook Import.
Enter the path and file name of the text file to import, or browse to it.

As needed, select the Quotes around field check box to specify that the entries
in the import file include quotes and the Publish imported entries check box to
make the imported phonebook entries available to other users.

Under Text Format, click the format of the import file.

Under Field Delimiter, click whether the fields within the import file are
separated by comma, tab, or space.

Under Duplicate ID Handling, specify the action to take when a duplicate ID is
encountered:

* To import the entry and replace the existing entry, click Replace the existing
entry.

* To import the entry and replace the existing entry if confirmed during
import, click Replace after confirmation.

¢ To import the entry and assign a unique ID, clickGenerate unique IDs.

* To not import the entry, click Skip.

Click Import . As needed, respond to confirmation messages for duplicate
entries.

6.4 Exporting the entries from your OpenText Fax
phonebook

You can export phonebook entries to a comma, tab, or space delimited text file.

To export the phonebook to a comma, tab, or space delimited text file:

1.

2.

On the Tools menu, click Phonebook Export.

To include phonebook groups as separate entries in the file, select the Export
Groups check box. The text file shows groups at the bottom of the file, listing
the IDs of the users in each group.

Click the delimiter to use to separate fields within phonebook entries: Comma,
Tab, or Space.

Click Export.

FXNET240400-UFD-EN-01 FaxUtil User Guide 47



Chapter 6 Creating and using phonebooks

6.5 Selecting MAPI, LDAP, or ODBC phonebook

6.6

entries

You can select entries from phonebooks other than the OpenText Fax phonebook
only if you have user permission to create and edit phonebooks. For information
about configuring MAPI, LDAP, and ODBC phonebooks, see the OpenText Fax -
Administrator Guide (FXNET-AGD).

To select recipients from a MAPI source:
1. Click Phonebook, and then click MAPI.
2. In the Profile Name box, select the MAPI profile name, and then click OK.

3. If prompted, enter your network user name, domain, and password, and then
click OK.

4.  In the contact list, double-click each contact entry you want to select, and then
click OK. You can search for recipients by name only or by data in other
columns.

The selected entries appear in the Current Recipients list of the Phonebook
window.

To select recipients from an ODBC or LDAP phonebook:
1. Click Phonebook.

2. On the tab of the phonebook, select the entries, and then click OK. Use the
arrow keys to show more records.

Customizing the columns in the phonebook

You can remove or add columns in the phonebook.
To add or remove columns:

1. Right-click any column header in the list.

2. Point to View. All items with a check mark appear as columns in the
phonebook.

3. You have the following options:
e (lick a selected item to remove it.

e (lick an unselected item to add it.

e To restore the default view, click Reset to Defaults.
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Chapter 7

Creating signatures, stamps, and library documents

With the appropriate permissions, you can create signatures, stamps, and library
documents.

Signature files are specially formatted graphic images (typically of signatures)
that you include in document files that you will be faxing. You can insert
signatures into fax-bound documents using the “SIGNATURE” embedded code.
To create a signature file, you must be a fax administrator.

Stamp files are graphic images that you can add to outbound and inbound faxes.
Administrators can create a library of stamps, and personal stamps can be
created by and for users (known as personal stamps). Each user can have one
personal stamp. When viewed in the client applications, stamps are listed in
alphabetical order, and the personal stamp appears first in the list. Personal
stamps are not included in the system library of stamp images.

Library documents are frequently faxed documents stored in fax format on the
fax server for easy access. You can also create library documents using the
“NEWLIB” and “NEWLIB2” embedded codes. You can create library documents
if your user profile includes that permission. For more information, see the
OpenText Fax - Administrator Guide (FXNET-AGD).

To create a signature file:

1.
2.

8.

Fax a signed document to yourself.

Open the fax in your FaxUtil mailbox.

On the fax page, using the selection box tool, select the signature image.
On the Fax menu, click Store, and then click Make Signature

In the Signature Code box, enter a unique ID for the signature.

Enter the Owner's User ID and a Description.

In the Authorized User IDs boxes, enter up to three user or group IDs of users
who can use the signature, including the owner’s User ID.

Click OK to save the signature file.

To create, edit, or replace a stamp file:

1.

2.

Using a graphics program, create a .gif, .tiff, jpg, .png, or .bmp image. The
maximum file size is 1 MB.

In FaxUtil, on the Tools menu, click Options. The Options dialog box opens.

FXNET240400-UFD-EN-01 FaxUtil User Guide 49



Chapter 7 Creating signatures, stamps, and library documents

N o g o

On the User Information tab, in the Personal Stamp box, click Change. The
Edit Stamp dialog box opens.

In the Description box, enter or change the description of the stamp.
Click Import, and the Import Stamp File dialog box opens.
Browse to locate the image file. Select the file, and then click Open.

In the Edit Stamp dialog box , click OK.

If you entered an existing description, confirm that you want to overwrite the
existing stamp file.

To create a new or overwrite an existing library document:

1.

SR I SN

Create the document in a word processor or other application and fax it to
yourself.

Open the fax in your FaxUtil mailbox.

On the Fax menu, click Store in Library.

Enter a Document ID and a Description.

Select the check boxes for the accessibility options you want to apply.

You can also set activation and expiration dates. Select the check box to enable
an option, and then select a date.

Click OK. The new library document will be immediately available for use in
outgoing faxes.

If you entered an existing document ID, confirm that you want to overwrite the
existing document.
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Chapter 8

Creating overlay forms

Overlay forms are fax image files that OpenText Fax can superimpose over outgoing
faxes to give them the appearance of having been printed on the form prior to
faxing. Typically they are replicas of documents that your organization uses such as
the company letterhead.

New form files are created from your mailbox in FaxUtil or FaxUtil Web and
managed in Enterprise Fax Manager or Web Admin.

You can create overlay forms if your user profile includes that permission. For more
information, see the OpenText Fax - Administrator Guide (FXNET-AGD).

To create an overlay form:

1.

Create the document in a word processor or other application and fax it to
yourself. You also can use a received fax.

On the main menu, select Fax and choose Store as form. The Store Fax as Form
dialog box opens.

In the Form ID box, enter a unique name to identify the form.
In the Description box, enter a description of the form.

In the Starting Page box, enter the first page after the cover sheet to which to
apply the form. If you enter 1, the form will appear on the first body page. Page
numbers are absolute. If you set the start page to 3 and a document only has
two pages, none of the pages will include the form.

To overlay each page of the fax with the form, select the Overlay on All Pages
check box.

In the Number of Pages box, enter the number of pages to which to apply the
form.

To restrict the form to specific groups of users, select the Secured check box.
Selected the group of users in the Authorized Group or User list.

If you are creating an overlay form from a received fax, you have the following
options for the transmit terminal information (TTI) line.

* To remove the TTI line so that it doesn't appear on the overlay form, select
Erase TTI Lines.

¢ Toremove the TTI line so that it doesn't appear on the overlay form and
adjust the size of the overlay form to fit the size of the faxed page, select Cut
TTI Lines. In the Adjust to Paper Size list, select the page size.
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10. Click OK. The new overlay form will be immediately available for use on
outgoing faxes.

To delete an overlay form — To delete an overlay form, see the OpenText Fax -
Administrator Guide (FXNET-AGD).
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Chapter 9

Defining mailbox preferences

To define mailbox preferences:

* (lick Options, and make your selections in the Sending, Receiving,
Notification, User Information, and Other Options tabs, and then click OK.

9.1 Defining sending preferences

On the Sending tab, you can change default sending selections for the New Fax
window and, if enabled for your user account, for automatic printing.

To define default send options:
1. Under Default Send Options select any of the following check boxes:

e Use Hold for Preview

¢ Use Smart Resume

e Use Cover Sheet.

¢ Prepopulate fax information on forward

* Create PDF image for email. Select this option to send PDF files instead of
fax format files when sending to email addresses. This setting can be
changed for individual faxes.

2. In the Automatic Deletion list, select if and when to automatically delete faxes:
Never, After successfully sent, or Always.

3. Inthe Priority list, select the default priority: Normal, Low, or High. The high
priority option is only available if your user profile includes the appropriate
permission.

4. In the Conversion Bias list, you can specify that documents be converted to fax
format to enhance text or graphics. This option is only available if your user
profile includes the appropriate permission

* To convert with a bias toward text legibility, select Optimize for Text.

e To convert with a bias toward graphical fidelity, select Optimize for Images.
* To convert with a bias toward both text and graphics, select High Contrast.
* To use the setting from the fax server, select Use Server Default.

e To not convert with bias, select None.
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To define automatic printing of sent faxes:

1. If available, under Automatic Printing, select the Automatically Print Sent
Faxes check box.

2. In the Printer list, select the printer, and then click Print Successful Faxes, Print
Failed Faxes, or Print All Sent Faxes.

3.  Select the check box for each part of the fax to print: History, Cover Sheet, and
Body Pages. if printing the fax history, you can include a small image of the first
page of the fax (typically this is the cover sheet). Select the Include thumbnail
of first page check box. Alternatively, to include a small image of the second
page of the fax, select the Skip cover sheet check box.

9.2 Defining receiving preferences

9.2.1

On the Receiving tab, you can define automatic processes for received faxes, such as
automatic forwarding, automatic printing, and automatic conversion to text using
OCR.

To not forward received faxes:

¢ (lick Do Not Forward Received Faxes.
Defining automatic forwarding

Note: The faxes are forwarded the way they are received. Required sending
information such as billing codes will not be filled in.

To automatically forward to a user:

1. Click Forward Received Faxes to Users, and then click
2. Inthe User selection list, click the user, and then click Add.

3. Repeat step 2 to add additional recipients. Click OK. You can enter up to 30
characters, including commas.

To automatically forward to a fax number:

1. Click Forward Received Faxes to Number.

2. In the text box, type the fax number.

To automatically forward to a group of users:

1. To forward to a group of users, click Forward Received Faxes to Group.

2. In the list, select the group.
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9.2.2 Defining automatic printing

To automatically print received faxes:

1. Select the Automatically Print Received Faxes check box, and then click Set
Print Options.

2. In the Selected Printer list, click the ID of the printer.

3. Define any additional print settings, and then click OK.

9.2.3 Defining automatic conversion to text (OCR)

To automatically convert received faxes to text:
1. Select the Automatically OCR Received Faxes check box.
2. Click Set OCR Options.

3. In the Output Type and Format lists, select the file type and format for the
output files.

4.  Under Page Range, specify which pages to output, and then click OK.

9.3 Defining notification preferences

The settings on the Notification tab determine when you will be notified about sent
and received faxes. Typically, fax notifications are sent to you via email although the
fax administrator may have created a custom notification system for your
organization. You also can choose desktop notifications.

To set preferences for sent faxes:

1. Under Send Fax Notifications, select the check boxes next to the sending events
about which you want to be notified.

2. In the During Transmission list, select if or when you want to receive
notifications about sent faxes in transmission: Never, Once Only, or
Periodically.

3. In the Incomplete Faxes list, select if or when you want to receive notifications
about incomplete faxes: Never, Once Only, or Periodically

To set preferences for received faxes:

* In the Received Faxes list, select if or when you want to receive notifications
about received faxes: Never, Once Only - When initially received, or
Periodically - While fax has not been viewed or printed.

To show desktop notifications for received faxes:

* On the Windows taskbar, in the notification area, right-click the OpenText Fax
icon, and then click Show Desktop Alerts.
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9.4

To route received fax notifications to another user:

1. Select the Notify an Alternate User check box , and then click EI

2. Inthe Search for Users box, enter a full or partial user name or OpenText Fax
user ID, and then click Search.

3. Select the user, click Add, and then click OK. To also notify the user of sent
faxes, select the Include sent fax notifications check box.

indicates if a user account is disabled, i if it is unprotected.

Changing your password and default user
information
On the User Information tab, you can change your password and information about

you that appears on the fax cover sheet. You also can add a profile picture. The
profile picture appears in FaxUtil and FaxUtil Web.

To change your password:

1. UnderUser System Information, click Change Password.

2. Type your current password in the Old Password box and your new password
in the New Password and Confirmation boxes, and then click OK.

If your organization requires strong passwords, enter a password that:

e Consists of at least 8 characters.
* Includes both upper- and lowercase characters.
* Includes at least one number or one of the following special character: * - =]

\;,//N!@#$%A&*_+{} |« 7 <>7?

If your organization does not use strong passwords, your password can be any
combination of letters (upper- and lowercase), numbers, and special characters.
The password is case-sensitive. You may use a blank password only if the fax
administrator has assigned you permission to do so.

3. (Click OK.
To change your cover sheet information:

® Under Cover Sheet Information, as needed, change your default user
information that appears on the cover sheet of sent faxes.

To add a profile picture:

Users with permission can upload a profile picture so that it appears in the header of
OpenText Fax applications. Your user group permissions determine if you can
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upload a profile picture. When a profile picture is not uploaded, then the default
image is the first two letters of the user name. In this case, administrator user names
appear with a red background, and non-administrator user names appear with a
blue background.

1. Using a graphics program, create a .gif, .jpeg, .jpg, or .png image. The maximum
file size is 1 MB.

2. Under Profile Picture, click Change.

3. Inthe Import Profile Picture dialog box, select the image file, and then click
Open.

4. In the Select Image Area dialog box, select the area of the image that will be
used for the profile picture.

5. Click OK. To change the image after it is saved, you must upload a new image.
To add a personal stamp file:

Images that are frequently used in faxes can be saved so that you can place the
images in faxes to personalize them. These are known as stamps. Administrators can
create a library of stamps, and personal stamps can be created by or for users. Each
user can have one personal stamp. Personal stamps are not included in the system
library of stamp images.

1. Using a graphics program, create a .gif, .tiff, jpg, .png, or .bmp image. The
maximum file size is 1 MB.

Under Personal Stamp, click Change. The Edit Stamp dialog box opens.
In the Description box, enter or change the description of the stamp.
Click Import, and the Import Stamp File dialog box opens.

Browse to locate the image file. Select the file, and then click Open.

SATR L

In the Edit Personal Stamp dialog box, click OK.

9.5 Defining general FaxUtil program preferences

On the Other Options tab, you can customize your interaction with FaxUtil.
To set miscellaneous program options:

*  On the Other Options tab, under Program Options, select the check boxes for
the options you want to activate. The options include:

— Enable automatic fax list updates (secs) — In the text box, enter the number of
seconds.

- New fax notification on startup — Be notified of faxes you have not yet
viewed when you start FaxUtil.
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- Allow multiple view windows — View multiple faxes at one time, each in its
own OpenText Fax Viewer window.

— Use Trash folder when deleting — Use the Trash folder as a temporary
storage for deleted faxes. This means that you can restore a file after deleting
it by moving it from Trash to another folder.

— Empty Trash folder on exit — Permanently delete files from the Trash folder
when exiting FaxUtil.

— Use OpenText Fax phonebook — Use the OpenText Fax phonebook to be able
to quickly apply fax destination information of individual users or groups of
users to outgoing faxes.

— Allow delegate duplicates in user list — A user for whom you are a delegate
will appear multiple times in the user list if the user is a member of a group or
groups for which you are a delegate.

— Show small folder icons — Reduce the size of the icons in the tree view in the
left pane of the FaxUtil window.

— Show text on toolbar buttons — Show or hide the descriptive labels on the
buttons on the toolbar in FaxUtil.

— Load each page into viewer on demand - Increase the speed for viewing a
fax with many pages. With this option, one page of the fax is uploaded to the
viewer until the next page is selected.

To set the default magnification for viewing faxes:

You can set the fax viewer to open faxes at your preferred magnification.
¢ In the Viewer zoom box, select the magnification level.

To change the date and time display:

¢ In the Date/Time format list, select a Short or Long format. When you select an
option with server time, the date and time of both the local computer and the
server will be shown.

To change the language:

¢ Inthe Language list, select the language. After you restart FaxUtil, the menus
and windows will be in the selected language.

To set the default print method:

If you set a default print method, then you won't be prompted to select from a local
printer or server printer when you click the print button. The option to print to a
server printer is only available if your user account allows printing to a fax server
printer.

* Under Default Print Method, select one of the following options:

- Always ask
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- Local print

— Server print
To set a default server printer:

1. Click Set Printing Options.

2. Inthe Selected Printer list, click the ID of the printer.

3. Define any additional print settings, and then click OK.

To set default OCR options:

1. Click Set OCR Options.

2. Select the file type and format of the output files.

3.  Specify which pages to output, and then click OK.

To make additional Phonebooks available:

* For each phonebook you want to add, in the Users list, select the OpenText Fax
user, and in the Password box, type the password.

To show optional windows:

¢ Under Optional Dialogs, select the check boxes of messages or dialog boxes you

want to see in FaxUtil.

Option

Description

Show print dialog when selected via toolbar

When printing a fax from the fax list, show
the print dialog box so that you can change
print options.

Show alternate body explanation

If your user permissions allow you to attach
alternate body pages, then when attaching a
file, you can have access to a message that
explains alternate body pages.

Show "No Reply-to Address" warning

When sending a fax to an email address,
show a message if your OpenText Fax user
account does not have an email address
configured.

Show route/forward dialog when dragging
faxes

When dragging faxes to a folder of another
OpenText Fax user, show the route or
forward dialog box so that you can add
recipients or enter notes.

Show "Pending Form Overlays" warning
when combining faxes

When splitting or combining a fax, show a
message that form overlays are in progress.
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Option

Description

Show image type choice

When opening a fax to view it, show a dialog
box in which you can select TIFF or fax
image file format.

Show phonebook duplicates dialog

When selecting duplicate recipients from a
phonebook when sending a fax, show a
dialog box in which you can select or delete
duplicates.

Remember folder location between sessions

When opening FaxUtil, the program will
return to the folder that you last viewed.
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Giving other users delegate access

You can give other OpenText Fax users delegate access to your fax mailbox so that
they can send or respond to faxes on your behalf. User permissions determine
whether you can assign delegates and whether you can delegate to individual users
or also to groups. When assigning delegates, you can assign delegate permissions
from existing roles or define and save custom roles. Custom roles that you create are
not shared with other users.

To assign delegates:

1. Click Delegates.

2. Inthe Search for Users or Groups box, enter a full or partial user or group ID,
and then click Search.

3. In the list of matching IDs, select the users and groups, and then click Add.

To remove a delegate from the Current Delegates list, select it, and then click
Remove.

4. Inthe Role list, select a role. To define a role from a blank list of permissions,
select None.

5. In the list of permissions, as needed, select and clear access options.

6. Click OK.
To customize and save a role:

1. With a delegate selected in the Current Delegates list, select a role in the Role
list.

2. In the list of permissions, select and clear access options. The selection in the
Role list changes to Custom.

3. Click Save Custom.

4. In the Custom Role ID box, enter a name for the custom role, and then click
OK. The role appears in the Role list.

To delete a custom delegate role:

1. With a delegate selected in the Current Delegates list, select a custom role in the
Role list.

2. Click Delete Custom, and then click Yes to confirm the deletion.
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Table 10-1: Read permissions

10.1 Default delegate permissions by role

Action\Role Owner Editor Reviewer
Can view faxes. X X X
Can view first page | x X X
of received faxes.

Can print faxes. X X X
Can view fax history. | x X X
Can browse all X X X
folders.

Can use phone X X X
entries.

Can export images. X X X
Can mail images. X X X

Note: The x in the preceding table indicates that the permission is available for

that action.

Table 10-2: Write permissions

Action\Role Owner Editor Reviewer
Can create faxes. X X --
Can edit faxes. X X -
Can update fax X X --
status.

Can forward faxes. X X -
Can OCR faxes. X X -
Can create folders X X -
Can rename folders. | x X -
Can create phone X X --
items.

Can edit phone items. | x X --
Can annotate faxes. X X -
Can move faxes. X X --
Can route faxes. X X --
Can route faxes X X -
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Action\Role Owner Editor Reviewer

Can annotate faxes X X -
with personal stamp

Note: The x in the preceding table indicates that the permission is available for
that action.

Table 10-3: Delete permissions

Action\Role Owner Editor Reviewer
Can delete faxes. X -- -

Can delete folders. X -- -

Can delete phone X - -

items.

Note: The x in the preceding table indicates that the permission is available for
that action.

Table 10-4: Miscellaneous permissions

Action\Role Owner Editor Reviewer
Can approve faxes. | x X -

Can modify user X - -
options.

Can modify X -- --
delegates.

Can toggle refuse fax | x X --
distributions.

Requires fax -- -- --
approval.

Notes

¢ The x in the preceding table indicates that the permission is available for that
action.

* The Requires fax approval permission does not apply to faxes that the user
creates, including faxes that the user creates as a delegate on behalf of
another user.
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Fax status and error messages

The following list describes the fax status and error messages.

A new fax has arrived for [UserID] from remote ID: [RemotelD]
Another user has designated you to be their alternate for notification and they
have received a new fax.

A new fax has arrived for [UserID] which hasn't been viewed or printed
A member of the group for which you are the fax administrator or alternate
administrator has received a fax and has not viewed or printed it within one
hour of receipt.

A new fax has arrived from remote ID: [RemotelD]
You have received a new fax. You will continue to be notified for one hour (or
other period specified by the administrator). If you do not view or print the fax,
your group's administrator will be notified. If he or she does not print the fax,
your group's alternate administrator will be notified.

An outgoing fax is ready for previewing
The fax that you requested to be held for preview has been processed by the fax
server and is waiting in your mailbox. You must release it to start the sending
process.

Answer tone detected
The fax server could not connect with the remote (receiving) fax machine due to
communication errors between the receiving fax machine and the fax server.

Bad FCS Information
Incorrect information was entered on the cover sheet.

Bad Formtype
You have specified an overlay form that does not exist or is corrupt.

Bad Phone Number
You entered an incorrect or nonexistent fax phone number.

Bad Signature Code
The code that identifies the signature file is not recognized, because it is corrupt
or it does not exist.

Call answered before one full ring
The fax server did not receive a normal-length ringback signal from the phone
service provider.

Carrier not detected
The fax server did not detect a dial tone when it tried to dial out.
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Command time exceeded
There are timing-related errors, possibly when the fax card waits for or sends a
command (T30 protocol handshaking commands) and doesn't get a response
within a given period or time.

Command time too short
There are timing-related errors, possibly when the fax card waits for or sends a
command (T30 protocol handshaking commands) and doesn't get a response
within a given period of time.

Command timeout
There are timing-related errors, possibly when the fax card waits for or sends a
command (T30 protocol handshaking commands) and doesn't get a response
within a given period of time.

Communications-line failure
The fax card was unable to make a valid connection with the remote (receiving)
fax machine.

Conversion Failed
The fax server was unable to convert the document to Group III format.

Dial failure or no dial tone
The fax server cannot detect a dial tone, because there is a problem with the
phone line or the fax card is configured incorrectly.

Duplicate
The fax is a duplicate. It has been forwarded to you by another user.

Equipment busy tone detected
The phone line of the remote (receiving) fax machine is busy.

Fax Discarded
The fax server threw the fax away. Contact your administrator.

Fax number busy
The fax server has tried to send the fax the required number of times, and each
time the phone number was busy. The default value is 5 tries.

Fax to [Name] abandoned, too many retries
The fax server will try to successfully send the fax a specified number of times
(determined by the administrator) then quit trying. The default value is 5 tries.

Fax to [Namel, [Error]
The outgoing fax encountered the error listed. (See the error listed for more
information.)

FCS Create Failed
The cover sheet of the fax could not be created due to a corrupt or incompatible
cover sheet.

Function not implemented
An operation was attempted that is not currently supported by the fax card
software.
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G2 Fax Machine
You have attempted to send a fax to a Group II machine, rather than a Group III
machine.

Held for Preview
The fax is held for your preview before it will be sent. You must release the fax
to start the sending process.

Human Answered
The fax server detected an unknown sound after it dialed the fax number. The
unknown sound could be a human voice, a recording, or line noise.

Illegal line number
You have attempted to send a fax on a fax channel that does not exist.

Illegal option in call
This error could occur if an invalid parameter is given for one of several
different commands, including LOG, DEBUG, XFER, and SEND.

Illegal parameter value
This error could occur if an invalid parameter is given for one of several
different commands, including: LOG, DEBUG, XFER, and SEND.

Illegal Sig. Use
You have included a signature file in the fax that you are not authorized to use.

Imaging error encountered, fax abandoned
The fax server was unable to convert the document to Group III format for
transmission, and so it quit trying.

In Conversion
The fax server is converting the document to fax format for transmission.

In Validation
The signature or billing codes in the fax are being validated against the fax
database.

Info Not Complete
Some of the required sending information is missing from the fax.

Initial Processing
The fax server is checking the document for embedded codes and calculating the
number of pages in the fax.

Invalid Billing Code
You have entered a billing code that is incorrect or does not exist.

Invalid Embedded Code
You have included a misspelled, incomplete, or nonexistent embedded code in
the fax.

Line in Use
The fax server was not able to send the fax, because there were no outgoing
phone lines available.
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Loop current detected
When the fax server attempts to go off-hook to send the fax, it finds that the
phone is already off-hook. This can occur when two devices are sharing a phone
line and attempt to use it at the same time. It might also be a fax card
configuration error.

Loop current failed
The fax card detected current on the line, but it did not detect a valid value for
LOOP CURRENT.

Loop current not detected
The fax card was looking for LOOP CURRENT before it attempted to dial the
fax number but didn't find any.

Network congestion detected
The network may be running inefficiently and causing traffic, or an invalid fax
number may have been dialed.

Network high and dry (no ring)
The fax card does not detect any type of telephone interface available. This is a
very serious error; contact your fax administrator immediately.

No Answer at Fax #
The fax machine at the receiving end didn't answer, or a wrong number was
dialed.

No answer tone detected
The phone is ringing at the destination, but the fax machine is not answering
within the specified time. This is especially prevalent in international calling
when it can take up to a minute to connect to the remote (receiving) fstation.

Non-G3 Modem Detected
The fax server has detected a non-Group Il fax modem on the remote
(receiving) fax machine and cannot communicate with it.

OCR error
An error occurred while a document was being sent to or in processing by the
OCR Module.

OCR in process
The fax has been queued and is being processed for optical character recognition
(OCR) by the OCR Module.

OK
The fax server has successfully sent the fax over the phone lines. This does not
guarantee successful receipt of the fax at its destination.

One of your outgoing faxes needs attention
Some of the required sending information is missing from the fax.

P2 was not detected at the end of training
There is a performance problem with the fax server and the number of fax cards
that it contains.
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Paper Fax Record
For the fax history record, the fax was manually recorded as sent or received on
a conventional fax machine.

Phone Line Problems
There is a problem with the phone lines at the fax server.

Poor Quality
There was too much line noise for the fax to be transmitted correctly. The fax
may have been sent, but it may be difficult to read.

Printing
The fax is printing.

Printing Error
An error occurred while the fax was printing.

Protocol reject message
This is a generic protocol error code that could have several meanings. In
general, the fax card in the fax server is having difficulty communicating with
the remote (receiving) fax machine, because it isn't getting the signals it
expected.

Protocol timeout
This is a generic protocol error code that could have several meanings. In
general, the fax card in the fax server is having difficulty communicating with
the remote fax machine, because it isn't getting the signals it expected in the
appropriate time frame.

Queued for OCR
The fax has been queued and is waiting for the OCR Module to convert it using
optical character recognition (OCR).

Queued for Printing
The fax has been queued and is waiting to be printed.

Ringback signal detected
A ringback signal was detected when it should not have been. This may be due
to interrupting a call in process on a shared line or could be caused by noise on a
T1 phone line.

Ringback, but no answer tone
The phone rang at the destination, but it was never answered. This might be
because the receiving fax machine is off-line or unable to receive faxes.

Ringback, then busy condition
The fax number that was dialed went off-hook and then went on-hook very
quickly, generating a fast busy signal.

Scheduled for Send
The fax was successfully converted to fax format and is now being sent to the fax
server to await sending. If you specified a date and time to send the fax, the fax
server will wait to send it then.
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Scheduling Failed
The fax was converted correctly, but it couldn't be correctly queued to be sent.

Sending
The fax server is transmitting the fax.

Sending fax to [Name] at [FaxNumber]
The fax is being sent to the name and fax number specified.

Sig Needs Authorization
You must be authorized to use the signature file that is included in the fax.

Training Algorithm detected FSK
There is a performance problem with the fax server and the number of fax cards
it contains.

Training Algorithm found on PN
There is a performance problem with the fax server and the number of fax cards
it contains.

Tx/Rx Error
The receiving fax machine was experiencing difficulties or excessive line noise.

Unknown Error
Undetermined error.

Unknown Error Code
Error condition is not known.

Unknown Status Code
An unknown status code has been returned to the fax server from the fax card.

Voice response to call
The fax server detected a sound that it didn't expect after it dialed the fax
number. The sound could be a human voice, a recording, or line noise.

Waiting for Conversion
The fax server is busy with another process and has queued the fax to be
converted.

Waiting to be Sent
The fax is waiting to be scheduled for faxing.

Your fax has been successfully sent to [Name] at [FaxNumber]
The fax was successfully sent over the phone lines. This does not guarantee
successful receipt of the fax at its destination.

Your outgoing fax contains an invalid billing code
You have either not entered a required billing code or entered one that does not
exist.
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OpenText Fax embedded codes

Embedded codes are faxing instructions that you insert into fax-bound documents.
You can use them to address faxes, include fax cover sheet information, attach
library documents, add billing information, insert your signature, and more. These
are not the same as the codes you can insert on fax cover sheets.

When the OpenText Fax server converts the document to fax form, it uses the
instructions contained in the embedded codes and then strips the codes from the
document.

Example: <TOFAXNUM:555-1212> The embedded code TOFAXNUM instructs the OpenText
Fax server to send the fax to the destination fax number 555-1212.

Example: <TOFAXNUM:{MERGEFIELD FaxNumber}> Together with mail merge from
Microsoft Word, the embedded code TOFAXNUM instructs the OpenText Fax server to send
the fax to the numbers included in the FaxNumber field of a data source.

If you send faxes via an SMTP gateway and use embedded codes, you must select
the Use PCL converter for text files option in your email configuration.

To add embedded codes to a document:

* Anywhere in a document that accepts text characters, type the code along with
any required parameters between angle brackets (KCODE:parameter>), observing
the following guidelines:

— Embedded codes can require no parameter <CODE>, have one parameter
<CODE:parameter>, or have multiple parameters
<CODE:parameter,parameter,parameter>.

- Every embedded code string (angle brackets, code, and parameters) in your
document must be formatted using a native printer font. Only native printer
fonts are stored in their original text format in the PCL file from which the fax
is generated. All other fonts are converted to graphic images.

— Incorrectly typed or formatted codes will be ignored and will appear in the
fax as text. Examples include mistyped codes, missing angle brackets, or code
strings in a font that is not a native printer font.

— Code statements that wrap to a second line will be ignored and will appear in
the fax as text.

Notes

¢ In very large documents that use embedded codes, the pre-scanning process
can cause the fax server to appear unresponsive. You can specify the
maximum length of time for embedded code processing by editing the
Windows registry PrescanTimeoutSeconds value.

FXNET240400-UFD-EN-01 FaxUtil User Guide 71



Chapter 12 OpenText Fax embedded codes

¢ In the following sections the embedded code that are prefixed with an
asterisk are compatible with OpenText Fax email gateways.

12.1 ADDDOC

Adds a file to the end of the fax. The specified file is not deleted after conversion. To
append multiple files to a document, add the ADDDOC code multiple times. The
files will be appended in the sequence in which the codes appear in the document.

Format <ADDDOCHfile>
Max field length N/A
Example <adddoc:\ \server8\sys\bin\xyz.tif>

To add an ADDDOC, ADDDOC2, ADDDOC3, or ADDDOC4 code:

* Specify the file path (\\ <ComputernName>\ <Folder>\<filename>.<extension>).
For a list of supported formats, see “File formats that convert to fax format”

on page 89.

Verify that OpenText Fax has access privileges to the file. If the attachment is
located on a client machine, verify that the client directory allows sharing so that

the server can access the remote file.

12.2 ADDDOC2

Replaces the document that contains it with the specified file. The original file will

be deleted.
Format <ADDDOC2:file>
Max field length N/A
Examples <adddoc2:\ \ server8\sys\bin\ 123.tif>

12.3 ADDDOC3

Adds a file to the end of the fax. The original file will be deleted.

Format <ADDDOCS3:file>
Max field length N/A
Examples <adddoc3:\ \ server8\sys\bin\ xyz.tif>
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12.4. ADDDOCA4

12.4

12.5

12.6

ADDDOC4

Replaces the document that contains it with the specified file. The original file is
retained.

Format <ADDDOCH4:file>
Max field length N/A
Example <adddoc4:\ \ server8\sys\bin\ xyz.tif>

*ATDATE

Schedules to send the fax on a specific date.

By default the current time on the specified day is used as the send time. For
example, if a fax is sent to the queue at 3:30 p.m. and it contains <ATDATE:+1> and
no ATTIME code, it will be scheduled to send at 3:30 p.m. the next day.

Format <ATDATE:date>

Max field length 10 characters

Example <ATDATE:+2>
<ATDATE:9-15-15>

To enter a date relative to the current date:

* Enter +<n>, where n is the number of days after the current date. For example, to
schedule the fax to send a week after the current day, enter +7.

To enter an absolute date:

* Enter a specific date using one of the following formats: <MM>/<DD>/<YY>,
<MM>-<DD-YY>, or <MM>-<DD>-<YYYY>.

*ATTIME

Schedules to send the fax at a specific time.

The fax will become eligible for scheduling within 15 minutes of the specified time.
Specifying a time between the current time and midnight will schedule the fax to
send the same day. Specifying a time earlier than the current time will schedule the
fax the next day.

Format <ATTIME:time>

Max field length 9 characters

Example <ATTIME:+2>
<ATTIME:10:00p>
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12.7

12.8

12.9

To enter a time relative to the current time:
Do one of the following:

¢ Enter +<n>, where n is the number of hours after the current time.

e Enter +<n.n>, where the first n is either 0 or the number of hours, and the n after
the decimal point is a number 1-9 for the number of six minute increments.

To enter an absolute time:

¢ Enter the time as <hhmm> or <hh>:<mm> in either 12-hour or 24-hour format. To
indicate A.M and P.M for 12-hour format, append a or p after the time.

*BILLINFO1

Assigns the first billing code to the fax.

Embedded billing codes must comply with any billing code verification rules set up
on the OpenText Fax server.

Format <BILLINFO1:code>
Max field length 15 characters
Example <BILLINFO1:4444>

*BILLINFO2

Assigns the second billing code to the fax.

Embedded billing codes must comply with any billing code verification rules set up
on the OpenText Fax server.

Format <BILLINFO2:code>
Max field length 15 characters
Example <BILLINFO2:5555>

BREAK

Note: Do not use a PostScript driver when using the <BREAK> code. Use a
PCL driver instead.

Breaks a single fax document into multiple faxes with multiple recipients.
The break occurs at the point where the code is encountered. Each separate fax in the

document must contain its own fax recipient information using the <TONAME> and
<TOFAXNUM> embedded codes.
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12.10. BROADCAST

12.10

12.11

Format <BREAK>
Max field length N/A
Example <BREAK>

When the fax server encounters the <BREAK> embedded code, it automatically
flushes any existing print formatting information that was contained in the file’s
print header.

Note: Therefore, use the <BREAK> code only within ASCII print stream files
that do not have print headers associated with them

BROADCAST

Specifies that the fax is a fax broadcast to increase the speed at which the broadcast
is sent. Unnecessary server processes are decreased or eliminated, including polling
for and returning of status information, requests for notifications, and automatic
printing of faxes. Printing of failed faxes is not effected by this embedded code.

Format <BROADCAST>
Max field length N/A
Example <BROADCAST>

*CHANNEL

Sends the fax on the specified channel of the fax board.

This can be useful if your organization sends priority faxes or fax broadcasts on
specific channels.

Format <CHANNEL:channel#>

Max field length N/A

Example <CHANNEL:3>
Listed in OpenText Fax DocTransport as
Channel #2

To specify the fax channel number:

¢ Increment the channel number found in OpenText Fax DocTransport by 1. (A
value of 0 would indicate that any available channel can be used.)
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12.12

12.13

12.14

COMPLETEEVENT

Generates completion events that can be used by the OpenText Fax API. This is
useful if you write code to send the status of the fax to a user, to a database, or to a
host application.

Format <COMPLETEEVENT>
Max field length N/A
Example <COMPLETEEVENT>

*CONVERSION_BIAS

Overrides the default conversion bias set for the server.
Enter the word or just the number for the option:

* none or 1 to not optimize the conversion.

* images or 2 to optimize for graphical fidelity.

¢ text or 3 to optimize for legibility of text.

¢ highcontrast or 4 to optimize for both text and images.

Format <CONVERSION_BIAS:bias>
Max field length N/A
Examples <CONVERSION_BIAS:TEXT>

*COVER

Generates a OpenText Fax cover sheet for the fax. If the user account sending the fax
is configured to automatically generate a cover sheet, only one cover sheet will be
generated.

The default cover sheet file will be used unless an FCSFILE embedded code specifies
a different cover sheet file.

Format <COVER>
Max field length N/A
Example <COVER>
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12.15. *DELETE

12.15

12.16

12.17

12.18

*DELETE

Deletes the fax from the user’s mailbox after it has been successfully sent, overriding
the default OpenText Fax auto-delete setting.

Format <DELETE>
Max field length N/A
Example <DELETE>

*DELETEALL

Deletes the fax from the user's mailbox after it has been sent or sending has been
attempted. It overrides the default OpenText Fax auto-delete setting.

Format <DELETEALL>
Max field length N/A
Example <DELETEALL>

DELETEFIRSTPAGE

Removes the first page of the fax.

Deletes the first page of the fax, for example if you include all embedded codes on
the first page and do not want this page sent.

This code is typically used when it is easier to add a page of embedded codes to the
front of a document than to insert production embedded codes into the print stream
coming from the host.

Format <DELETEFIRSTPAGE>
Max field length N/A
Example <DELETEFIRSTPAGE>

DELETELASTPAGE

Deletes the last page of the fax, for example if you include all embedded codes on
the last page and do not want this page sent.

This code is typically used when it is easier to add a page to the end of a document
than to insert production embedded codes into the print stream coming from the
host.

Format <DELETELASTPAGE>
Max field length N/A
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12.19

12.20

12.21

12.22

Example

<DELETELASTPAGE>

*FCSFILE

Uses the specified file as the OpenText Fax-generated cover sheet.

The cover sheet file must exist in the OpenText Fax\FCS folder on the OpenText Fax
server and must end with the extension .pcl. Do not specify a directory path.

Format <FCSFILE:filename>
Max field length 12 characters
Example <FCSFILE:MYCOVER1.PCL>

FORMTYPE

Overlays the fax onto the specified OpenText Fax form.

Format <FORMTYPE:formID>
Max field length 15 characters
Example <FORMTYPE:LETTERHEAD>

*FROMFAXNUM

Displays the sender’s fax number on the OpenText Fax-generated fax cover sheet.
The code will be ignored if OpenText Fax does not generate a cover sheet.

Format <FROMFAXNUM: faxnumber>
Max field length 31 characters
Example <FROMFAXNUM:(520)555-1234>

*FROMGENFAXNUM

Displays the company fax number on the OpenText Fax-generated fax cover sheet. If
no cover sheet is generated by OpenText Fax, this code will be ignored.

Note: The PCL Cover sheet code equivalent of this embedded code is

<GENERALFAXNUM>.
Format <FROMGENFAXNUM: faxnumber>
Max field length 31 characters
Example <FROMGENFAXNUM:(520)555-2345>
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12.23. *FROMGENPHONE

12.23 *FROMGENPHONE

Specifies the company voice number to be placed on the OpenText Fax-generated
fax cover sheet. If no cover sheet is generated by OpenText Fax, this code will be

ignored.

Note: The PCL Cover sheet code equivalent for this embedded code is

<OPERATORNUM>.
Format <FROMGENPHONE:voicenumber>
Max field length 31 characters
Example <FROMGENPHONE:(520)555-3456>

12.24 FROMNAME

Specifies the sender’s name to be placed on the OpenText Fax-generated fax cover
sheet. If no cover sheet is generated by OpenText Fax, this code will be ignored.

Format <FROMNAME:name>
Max field length 59 characters
Example <FROMNAME:Jane Doe>

12.25 *FROMPHONE

Specifies the sender’s voice number to be placed on the OpenText Fax-generated fax
cover sheet. If no cover sheet is generated by OpenText Fax, this code will be

ignored.
Format <FROMPHONE : voicenumber>
Max field length 31 characters
Example <FROMPHONE:(520)555-4567>

12.26 *IGNORE

Causes all subsequent embedded codes to be ignored.

Format <IGNORE>
Max field length N/A
Example <IGNORE>

FXNET240400-UFD-EN-01

FaxUtil User Guide 79



Chapter 12 OpenText Fax embedded codes

12.27 *LIBDOC

Sends the specified OpenText Fax library document instead of the document. You
can specify multiple library documents, each as a separate LIBDOC code.

| Important

®  When used with email gateways, this embedded code functions exactly the
same as LIBDOC2.

Format <LIBDOC:documentID>

Max field length 21 characters

Example <LIBDOC:INFOPACK1>

12.28 *LIBDOC2

Sends the specified OpenText Fax library document in addition to sending the
document. You can specify multiple library documents, each as a separate LIBDOC2

code.
Format <LIBDOC2:documentID>
Max field length 21 characters
Example <LIBDOC2:INFOPACK1>

12.29 NEWDEST

Sends the document to multiple recipients. The <NEWDEST> code must appear after
every destination. If <NEWDEST> is omitted for a destination, the last occurrence of

any of the embedded codes takes effect. For each destination (recipient), you can use
the following codes:

¢ BILLINFO1

e BILLINFO2

e DELETE (To override a recipient’s delete preferences.)
e TOCITYSTATE

¢ TOCONTACTNUM

¢ TOCOMPANY

¢ TOFAXNUM

e TONAME

* SAVE (To override a recipient’s save preferences.)

Format <NEWDEST>
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12.30. NEWLIB

12.30

12.31

Max field length

N/A

Example of sending a fax to three recipients.

<TONAME:JOHN>
<TOFAXNUM:555-1234>
<NEWDEST>
<TONAME:MARY>
<TOFAXNUM:230-5000>
<NEWDEST>
<TOFAXNUM:555-3006>
<SAVE>

<NEWDEST>

NEWLIB

Creates or updates a library document from the document containing the code.

To create or update a library document, enter a new or existing library document ID
and description. The current document will either replace or create the specified

library document:

e If the document ID already exists, that library document will be replaced.

e If a matching document ID does not exist, a new library document will be

created.

The newly created library document will be assigned LAN accessibility only. To
specify other accessibility options, use the NEWLIB2 code instead.

Format <NEWLIB:libdocID,description>
Max field length N/A
Example <NEWLIB:novpricesheet,november_prices>

NEWLIB2

Automatically creates or updates a library document from the document containing

the code.

NEWLIB2 functions the same way as the NEWLIB code, except that you can also
assign any of the following accessibility attributes to the library document:

e L=LAN

e F =Fax on Demand

e W=Web

e (C=_Catalog

Format <NEWLIB2:libdocID,description, LFWC>
Max field length N/A
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Example

<NEWLIB2:novpricesheet,november_prices,
LEWC>

12.32 NOBODY

Sends only the cover sheet, and not the fax body. Any embedded codes not used for
the production of the cover sheet will be ignored.

Format <NOBODY>

Max field length N/A

Example <NOBODY>

12.33 NOCOMPLETEEVENT
Disables complete events.

Format <NOCOMPLETEEVENT>
Max field length N/A

Example <NOCOMPLETEEVENT>

12.34 *NOCOVER

Turns off automatic OpenText Fax cover sheet generation for the document.

Format <NOCOVER>

Max field length N/A

Example <NOCOVER>

12.35 NOSMARTRESUME
Disables the Smart-Resume feature.

Format <NOSMARTRESUME>
Max field length N/A

Example <NOSMARTRESUME>
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12.36. NOTE

12.36

12.37

12.38

12.39

NOTE

Adds comments to your cover sheet. OpenText Fax will not reformat or line wrap
the comments.

You can use up to 21 <NOTE> codes in a single document. This is helpful if you
want to enter multi-line comments.

Format <NOTE:text>
Max field length 69 characters
Example <NOTE:THE QUICK BROWN FOX JUMPS

OVER THE>
<NOTE:LAZY DOG.>

NOTIFY_ERROR

Sends a notification when the fax is abandoned due to transmission errors.

Format <NOTIFY_ERROR>
Max field length N/A
Example <NOTIFY_ERROR>

Notify_ embedded codes send notifications to the sender’s notification address
specified in their OpenText Fax user account.

NOTIFY_OK

Sends a notification upon successful transmission of the fax.

Format <NOTIFY_OK>
Max field length N/A
Example <NOTIFY_OK>

NOTIFY_RETRY

Sends a notification when a transmission error is encountered and the fax is being

resent.
Format <NOTIFY_RETRY>
Max field length N/A
Example <NOTIFY_RETRY>
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12.40 *PREVIEW

Holds the fax for preview in the sender’s mailbox. It must be released in FaxUltil or

FaxUtil Web to send.
Format <PREVIEW>
Max field length N/A
Example <PREVIEW>

12.41 *PRIORITY

Sets the priority of the outgoing fax to low normal or high. If you specify high
priority and do not have the permission to do so, the fax will be sent with normal

priority.

You can enter the priority using the word or just the initial letter:

e HIGHorH
¢ NORMAL or N
e LOWorlL

Format <PRIORITYpriority>
Max field length N/A

Examples <PRIORITY:HIGH>

12.42 *RETRYCOUNT

Specifies the number of times the fax will be retried in case of a non-fatal error, such
as a busy signal. A value of 0 means the fax server will use the system defaults.

Format <RETRYCOUNT:#>
Max field length 2 digits
Example <RETRYCOUNT:3>
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12.43. *RETRYINTERVAL

12.43 *RETRYINTERVAL

Specifies the minimum delay in minutes before a failed fax transmission is
rescheduled to send

Format <RETRYINTERVAL:#>
Max field length 2 digits
Example <RETRYINTERVAL:2>

12.44 *SAVE

Instructs OpenText Fax to not delete the fax image from the user’s mailbox after
sending. This overrides any default auto-delete setting.

Format <SAVE>
Max field length N/A
Example <SAVE>

12.45 SIGNATURE

Note: OpenText Fax signature files are not supported in outbound PDF
documents and do not appear correctly in documents converted using a
PostScript driver. Use a PCL driver instead.

Inserts the specified signature image into the document at the location of the code.
The left-middle point of the signature will align with the left-middle point of the
code, unless the client registry key SignaturePositionPercent has been set to change
this position.

You can include an unlimited number of <SIGNATURE> codes in a document. The
fax server fails the fax if you are not an authorized user of the signature file.

Format <SIGNATURE:signaturel D>
Max field length 21 characters
Example <SIGNATURE:BOB>
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12.46

12.47

12.48

12.49

*SMARTRESUME
Enables the Smart Resume feature.
Format <SMARTRESUME>
Max field length N/A
Example <SMARTRESUME>
TOALTFAXNUM

Specifies an alternate fax number that will be tried if the server is unable to send the
document to the primary fax number. This number will not appear on the fax. It will
only be used if sending to TOFAXNUM fails.

Format <TOALTFAXNUM:faxnumber>

Max field length 31 characters

Example <TOALTFAXNUM:520-555-1212>
TOCITYSTATE

Displays the fax recipient’s city and state information on the cover sheet. This code

can also include the full street address.

Format <TOCITYSTATE:city, state>

Max field length 59 characters

Example <TOCITYSTATE:TUCSON, AZ>
Displays the specified fax recipient company name on the cover sheet.

Format <TOCOMPANY :company>

Max field length 59 characters

Example <TOCOMPANY:ACME, INC.>
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12.50. TOCONTACTNUM

12.50 TOCONTACTNUM

Displays the specified fax recipient voice number on the cover sheet.

Format <TOCONTACTNUM:phonenumber>
Max field length 31 characters
Example <TOCONTACTNUM:520-555-1212>

12.51 TOFAXNUM

Sends the fax to the specified fax recipient fax number and displays it on the cover

sheet.
Format <TOFAXNUM:faxnumber>
Max field length 31 characters
Example <TOFAXNUM:520-555-0199>

12.52 TONAME

Displays the fax recipient’s name on the cover sheet and, if a matching entry is
found in your OpenText Fax phonebook, sends the fax to the fax address or
addresses of the individual or group entry.

Format <TONAME:name>
Max field length 59 characters
Example <TONAME:JANE DOE>

To use a published entry from another user’s OpenText Fax phonebook

* Instead of name, enter UserID!Entry.

12.53 UNIQUEID

Specifies a unique ID for the fax instead of having one automatically generated by
OpenText Fax. Custom unique IDs can be used for external document tracking

systems.
Format <UNIQUEID:faxID>
Max field length 15 characters
Example <UNIQUEID:XYZ120396>
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Chapter 13

File formats that convert to fax format

The following table lists the types of documents that the OpenText Fax conversion
engine can convert to fax format.

Conversion of PDF attachments and Postscript requires the OpenText Fax PDF

module.
Application or Supported versions Common Extension
file format
Ami Pro All versions SAM
ANSI text (7 & 8 bit) All versions TIXT
ASCII text (7 & 8 bit) All versions TIXT
Bitmap Windows versions .BMP
Multi-page PCX Microsoft Fax .DCX
EPS If TIFF image is embedded .EPS
G3 All versions .G3
.BG3
GIF All versions .GIF
HTML Versions through 4.0 HTM
HTML
JPEG All versions JPG
JPEG
.EXIF
Lotus 1-2-3 All versions 123
Lotus Wordpro All versions LWP
Microsoft Excel Versions 2000 - 2019 XLS
XLSX
XLSM
Microsoft Outlook All versions MSG
Microsoft PowerPoint Versions 2000 - 2019 PPT
PPTX
.PPTM
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Application or

Supported versions

Common Extension

file format
Microsoft Rich Text Format | All versions .RTF
Microsoft Visio 2000 - 2019 .VSD
Microsoft Word 2000 - 2019 .DOC
.DOCX
.DOCM
Microsoft WordPad All versions IXT
WPC
Microsoft Works Versions through 8.0 .WPS
Microsoft XML Paper All versions XPS
specification
MIME All versions MHTML
PCX bitmap All versions PCX
Portable Document Format | All versions .PDF
Portable Network Graphic All versions PNG
Post Script All versions .PS
.EPS
Text-based configuration files | Varies by product FTP
FRM
.WPC
TIFF CCITT Group 3 & 4 All versions .TIFF
Unicode Text MSWord with encoding .UNI
.UTF8
.UTF8e
UUEncode No specific version TIXT
vCard All versions .VCF
Visio All versions .VSD
XML All versions XML
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